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Introduction

* You don’t have to output everything to a terminal window in
Java.

* In this lecture, you'll be writing a calculator program that
makes use of forms.

* The form will have buttons and a text box.

* We'll start off with a very simple calculator that can only add
up, and then extend its capabilities so that it can subtract,
divide and multiply.

* The calculator will look something like this:
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NetBeans and Java Forms

* The NetBeans development environment, has greatly
simplified the creation of forms, and we’ll use this to drag and
drop controls onto a frame.

* Rather than go through reams of GUI theory, we'll just jump
straight into it.
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* Create a new project for this by clicking File > New Project
from the NetBeans menu at the top.

* Select Java > Java Application from the list boxes, and then
click the Next button.
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* On step 2 of the wizard, type MyCalculator as the project
name. At the bottom, uncheck “Create main class”.

* This is because a main method will be created for us by
NetBeans when we add a form.

* Step 2 of the wizard should look like this:

Name and Location

Project Name: MyCalculator

Project Location: | C:\Documents and SettingsikayspciMy DocumentsiNet

Project Folder: s and SettingsikayspciMy Documents\NetBeansProject
[ ] Use Dedicated Folder for Storing Libraries

Different users and projects can share the same
compilation libraries (see Help for details).




* Click the Finish button, and NetBeans will create the project,
but not much else.

* Have a look at the Projects area on the left in NetBeans and
you should see this (If you can’t see the Projects area, click
Window > Projects from the NetBeans menu at the top)

‘Projects 4 x "Files :Services
SR gy Calculator S
=g} Source Packages
; B;[ <default package>
) Test Packages

@ Libraries
(& Test Libraries

12

o+
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* Normally, there’s a java file under the Source Packages name.
But because we unchecked the “Create main class” box,
there’s no java class file there.

* What we’ll do is to add a Form to the project.

uuuuuuuuu

* When the formis & S — 6 5 o
=g Sour E=1

[5] Java Package...

created, it will be W q b ”
! (@ Llibrai  Clean and Build B Jaya Interface... e
created |n Its own & Stringvar  Clean +_!JPaneIForm...
Generate Javadoc \="| Frame Form...

nain - Navigat

java class file. Run ) Entty Clss..

{&) Entity Classes from Database...

Debug
* To add a form, profie & other...
. . ) Test Alt+F6
right click the project Set Configuration b

: Output

llnrab ae bl ain Nvaiack

name in the Projects window.
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Form

* Select New > JFrame Form from the menu.
* When you do, you should see the following wizard appear:
* Here, you are being asked

Name and Location

for a name for your Class, and ... wocouss

a package name. Profetts.[casaam

ocation: urce Packages
« We've already created the ... . y
proj ect’ and Ca“ed it Created File: |immer 2011\JavalLecturesiLecture 13\MyCalculatorisrc)JCalculatortJavaCalculator. java

MycCalculator.

The package name and class will go into the project.

So, for your Class Name type JavaCalculator.

In the blank package text box, type jCalculator.

Dr. Ahmed ElShafee, Fundamentals of Programming Il, Fall
2013

* So we're creating a class called JavaCalculator, which is in the
jCalculator package, which is in the MyCalculator project

* Click the Finish button to complete the process.

* When the wizard is finished, it will create a blank form in the
main window:

ava | |& IfEkeStatment0] java x | [ IFElseStatment02.java x| [ JavaCalculstor.java = [« +I[=)(T] :patette B ox
‘|| Source | Design HE - B LE PR > £ - Swing Containers ~
L_| Panel [*] Tabbed Pane
'y’ The Properties window deplays edtable settings for the selected components. X | Spit Pane bt Scroll Pane
[ Tool Bar 7 Desktop Pane
[ Internal Frame: || Layered Pane
= Swing Controls
el Label %] Button
(58] Toggle Button = Check Box
= Radio Button = Button Group o
[JFrame] - Properties B x
Properties |  Bindng Events Code
- Wm -~
defaultCloseOperation EXIT_ON_CLOSE  » []
title [m]
=/Other Properties
alwaysOnTop O ]
atwavsOnTooSuooorted ~
[JFrame] 7]

Dutput ¥ = Tasks




* The form is a blank, at the moment, and has an orange
rectangle surrounding it.

* The orange rectangle means that the form is the currently
selected object.

* Click away and you’ll see a blue rectangle instead. This means
that the form is not selected.

* Click back onto the form to select it, and you’ll see the orange
rectangle again.

I
* Note the two buttons at the top, Source and T ¥néx re
] § D BES-(B-
DESIgn. ...ava | &) IfElseStatment0l.java x | [&
|| source | Design | [QEA & &

* You’'re in Design at the moment.
» Click on Source 5q,see-the following cods: , r

2013

§§ Use the Source button (in the toolbar’

* You can expand and package jCalculator:
&
ContraCt the plus Sym b0|s public class JavaCalculator extends javax.swing.JFrame {
to reveal and hide code.

public JavaCalculator () {
initComponents () :

—0 @

* Notice,though, that a
main method has been
created.

}

®

@SuppressWarnings ("unchecked"”)

’ Generated Code

®

* When the program starts =~
it’S the main methOd that :2 pu.bl).c ;tatic void main(String args[])

Wl” be Ca”ed java.awt.EventQueue. invokeLater (new Runnable() {

new JavaCalculator () .setVisible(true):;

publie vold Fun() {
* It’s creating a new object { )
from our form, and s
setting its visible
property to trues anmed eishafee, £




‘Projects 40 x| ‘Files

‘Services

=& A
=I5 Source Packages
=[5 jiCalculator
B o ccacsaionove
Have a look at the Projects area (@ TestPackages
3 ’ #-I@ Libraries
on the left again. You’ll see that -G Test Lbraries !
a package and a |
:Palette 0 x
class file have been added: li]s“"'ﬁllf""t“"m ey 4
Pane T Pane
Click back on the Design button JL spit Pane [ Scrol Pane
at the top. [Z Tool Bar 5 Desktop Pane
™ Internal Frame |%] Layered Pane
You'll see your blank form again. = Swing Controls
iabel Label (0K} Button
To the right, you’ll have noticed (@) Toggle Button @~ Check Box
two areas: a Palette with a lot of T § Bl
s T F [1=] Combo Box {1 List
controls in it, and a Properties v =
darea. [EL Scroll Bar b Slider
. i =] Progress Bar [27] Formatted Field
The Palette should look like this: I e
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2013 {—| Separator |T| Text Pane 3
. _E[JFrame] - Properties W x|
And the Properties area should look | "t Gndne vers code
like this: - Properties A
. defaultCloseOperation |EXIT_ON_CLOSE v [_]
(If you can’t see them, click ttle ()
- . =IOther Properti
Windows > Palette and Windows > oo < -
Properties from the NetBeans siwaysOnTopSupported
background O [236,233,216) E]
menu.) bounds <Not Set> )
cursor Z_l__)efaull: Cursor v ()
enabled (J
extendedState 0 )
focusCycleRoot , )
focusTraversalPolicy | <default> v E]
focusTraversalPolicyProvide [ mL

[JFrame]
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A property of an object is a list of
the things you can do with it, like
set the background color, set the
text, set the font, and lots more.

Let’s change the title.

Make sure your form is selected.
If it is, it will be surrounded with
an orange rectangle.

The properties area will say
JFrame at the top.

Click inside of the title area and
type Calculator:

[JFrame} - Properties 0 x
P'ropert'ies Binding Events Code
- Properties A
defaultCloseOperation EXJ_OE_C@ e E]
[ cicitor m)
\=I0ther Properties
alwaysOnTop | )
alwaysOnTopSupported
background O (236,233,216 J
bounds <Mot Set> m
cursor Default Cursor v ()
enabled [;]
extendedState 0 ()
focusCycleRoot J
focusTraversalPolicy | <default> ~ )
focusTraversalPolicyProvide [ |
title
(java.lang.String) title
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Project MyCalculator does not have a main ...

Select the main class:

jCalculator, JavaCalculator

Then press the enter key.

To see what effect changing the
title property has, run your
program in the usual way.

When you run the program for
the first time, NetBeans will
display a dialogue box asking
you which main method you
want to use:

You only have one, which is in
your JavaCalculator class, so
just click OK.

[ oK ” Cancel ]

9[=1E

B calculator

+ Your form shoukdstirerieppearst:of i




Components

* The form has the title you just
typed, plus some default icons
for minimize, maximize and
close.

* Click the X to close your
program, and return to the
Design environment.

e What we need now is a text box
and some buttons.

e Let’s add the text box first.

* Locate the Text Field control in
the Palette:

:Palette
- Swing Containers
__| Panel
|1 Split Pane
[ Tool Bar

|| Internal Frame
- Swing Controls
ubel Label

(0] Toggle Button
@~ Radio Button

Li=| Combo Box

(Bl Scroll Bar
1 Progress Bar
[+] Password Field

(—| Separator

[ ] Tabbed Pane
[mﬂ Scroll Pane
55 Desktop Pane

| | Layered Pane

|9x] Button

i Check Box

& Button Group
f-4 List

|'*| Text Area

i b Slider

[#-7] Formatted Field
[12] Spinner

| T | Text Pane
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* Controls in the Palette can be
dragged onto a form. So click
on Text Field to select it.

* Now hold you left mouse
button down on the Text Field.

* Keep it held down and drag the
control onto the form:

Dr. Ahmed ElShafee, Fundamentals of Prog
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lTexigldl

(ITextFieldi |




* The squares around the text field are sizing handles. You can
hold down your left mouse button on one of the squares and
drag to a new width or height.

* The dotted lines are position indicators, one for the left
position and one for the top position.

* Notice that the default name for the text field is jTextField1l.

Let’s change that. ‘Navigator ' Inspector a x
B Form JavaCalculator
* With the text field selected, #-5 Other Components
=77 [oFrame]

have a look at the Inspector area = TR

in the bottom left: (If you can’t

see an Inspector area, click

Window > Navigating 2 Inseecter.from the NefBeans menu bar)

2013
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B Form JavaCalculator
+-E Other Components

-] [SFrame] Edit Text
-

Bind
Events

Anchor

v v wv w v w

* Asyou can see, jTextFieldl is Auto Resizing
selected in the Inspector. Set Default Sze
. . Space Around Component...
* This area shows you what objects Endose In >
you have on your forms. Propertes
* You can also rename an object
from here- New Name: |txtDisplay

* To do so, right click on jTextField1.
From the menu that appears, |
select Change Variable Name. Navigator Finspector 5

oK I[ Cancel ]

Bl Form JavaCalculator

* When you click on Change Variable [ & o components
Name, a dialogue box appears. =[] DFrame)

(-
* Type a new name for the Text




Now have a look at your code again by clicking the Source

button in the main window.

When your code appears, scroll down to the bottom.

You'll see that a new private field variable has been added:

public static void main(String args([])

{

java.awt.EventQueue. invokelLater(new Runnable() {

public void run() {

new JavaCalculator () .setVisible(true):

}
)

private javax.swing.JTextField txtDisplay:;

2013

. txtDisplay [JTextField] - Properties
Properties |  Binding Events Code

So a JTextField variable has been set up
with the name txtDisplay.

The “javax.swing” part is a reference to a
set of packages that are used for GUI
development.

Click on the Design button at the top to
return to your form.

The text field has some default text in, at
the moment.

You can add your own text by changing
the text property of the text field.
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= Properties

background [ [255,255,255]
columns 0

document <default >
edtable

font Tahoma 11 Plain
foreground B [00,0)
horizortalAlignment |LEADING
et JrexFienst
toolTipText null

=/Other Properties

ul <default >
UiClassiD TexdField

action

text
(java.lang.String) the text of this component

 txtDisplay [JTextField] - Properties
Properties | Binding Events Code
=Properties

background O [255,255,255)
columns 0

document <default>
editable

fort Tahoma 11 Plain
foreground W 000]
horizontalAlignment LEADING
E——

toolTipText null

=/ Other Properties

Ul <default>
UlClassiD TexdField

action

(java.lang.String) the text of this component

=
v
X

< <

<

D00 000000066

< <

<

D00 000000000

>

<

<




The text field on our calculator will
obviously be used for the output of the
calculation.

You add a button to a form in the same "

= Smiog Containers
way you do for text fields — drag and m
Fop e
As we’re going to be adding lots of ;Tim‘m"
buttons, it’s a good idea to add the (@] Togge Button
buttons to a control called a Panel. e

If you need to move the buttons, you Sy

= Progress Bar

can then just move the Panel instead. i
All the buttons will then move with the >

[ ] Tabbed Pane |
\ofi Scroll Pane
-3 Desktop Pane

|® | Layered Pane ‘

|0K] Button

@~ Check Box |
%~ Button Group |
{54 List

|| Text Area ’
b Slider

[7] Formatted Field

L2/ Spinner

T | Text Pane

pa ne | . Dr. Ahmed ElShafee, Fundamentals of Programming I, Fall
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Drag one on to your form. You can’t
see a Panel, as they’ll have the same
color as the form.

But you can select it:

Drag the sizing handles so that the
Panel fills most of the form
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‘Palette

[ Tabbed Pane
it Scroll Pane
‘;E Desktop Pane

| | Layered Pane

|0k] Button

i~ Check Box

£~ Button Group

£ List

['%] Text Area

b Slider

(7] Formatted Field
Liz] spinner

| T| Text Pane

= Swing Containers
[ Panel
L spiit Pane
[ Tool Bar
[ Internal Frame
- Swing Controls
labet Label
We can now add a button. (6 Toggle Button
®~ Radio Button
Locate the Button control in the 5] Combo Box
Palette: (et hold
[EL Scroll Bar
Drag one on to your Panel control: £ Progress Bar
[==] Password Field
The default name of the button is [ separatr
jButtonl. Change this name just like
you did for the text field: right click in
the Inspector area, and select Change e ]

variable name.

Change the name of the button to
btnOne:

® Rename

New Name: btnOne

— _ | ok || cancel |
. Ahmed ElShafee, Fundamentals of Programmin
2013
The name of the button will have ‘Navigator ' Inspector @ x

B Form JavaCalculator

changed in the Inspector:

- == [IFrame)
A new line of code has also been y i

added:

L Other Components

[] txtDisplay [ITextField]
= |_] jPanell [IPanel]

S TIlbtnOne [JButton]

The new variable name is btnOne,

and it is a JButton object, which is
a Swing control.

Note, too, that a variable has been
set up for the panel (we’ve left
this on the default name).

Dr. Ahmed ElShafee, Fundamentals of Programming Il, Fall
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private javax.swing.JButton btnOne;
private javax.swing.JPanel jPanell;
private javax.swing.JTextField txtDisplay;




=

‘btnOne [JButton] - Properties

Properties |  Binding Events Code
o o
background O [236,233,2186) L)
font Tahoma 11 Plain )
foreground W (000] .
e on | “0
Go back to Design view and make sure th%:I .
button is selected. T — L
We can change the text on the button.  wecomes & B
alignmentX 0.0 2
What we want is a number, one number s o= L1
for each button on the calculator. (ava.lng,String) The buton's text
The text property is used for button text.
So locate this property in the properties
window. Eae
Delete the default and type the number 1
instead:
Press the enter key on your keyboard and
you should see the text change on your
bUtton. It WI” aE.dhbeéElF@@fzféaa;gigtalsofProgrammmgn, rail
:btnOne [JButton] - Properties » x|
Properties |  Binding Events Code '
selected |__| : lJ A\
selectedicon ~()
verifylnputWhenFocusTarge ) )
verticalAlignment CENTER v ()
verticalTextPosttion CENTER v ()
- Layout -
g HorizontalSize  Joefauk 9
You can change the size of the Vertical Size Defaut g
. . . orizontal Resizable I:l
button in the properties Window.  Vmesmesme 0
Locate Horizontal a!:\.ccessibleName 1 )
. ‘ . Accessible Description null . Q
SIZe and Ve rt'CaI SIZE, Under the Accessible: btnOne [JButton] - Properties [ x_'
Layout heading: ':iLam s A -Propertijes Binding Events Code s
ackh
Change these values Yoies sz = o __ e
. Horizontal Resizable _ Tahoma 11 Plain [N
dEfal‘”t to 5 Of 30 Vertical Resizable O foreground W (00,0 ls
You can also change the font and s '8
font size in the properties window. - L G
. =/Other Properties
Make sure your button is selected. UiClassID 0
actionCommand 1 [;]
Now locate the font property. alignment 0.0 @
alignmenty 0.5 (MR

Click the small button to the right of font

Dr. Ahmed ElShafee, Fundamentals of Programmin, (java.awt.Font) The font for the component.

the font row: 2013




® btnOne [JButton] - font @

Set btnOne's font property using: | Default editor v

[] Derive the font from the default font

Font: r’ontstyle: Sze
When you click the font o Jie -

18thCentury A | Plain A |10 A |
button, you should see a e e P E—
dialogue box appear. encoaius dl &l s
Change the font size to 14 Previw

. . Tahoma 14 Bold

points, and make it bold:
You now need to add nine o _J[Cconcel ]

more buttons in the same
way, for the numbers 2to 9,
and a 0.

Change each variable name to
btnTwo, btnThree, btnFour,
efc.
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:JavaCalculator.java ... :Inspector a0 x
& Form JavaCalculator
&3] Other Components
] L:; [IFrame]
[] txtDisplay [JTextField]
=-_| jPanelt [IPanel)

i=]

HEREREREEE

btnOne [JButton]
btnTwo [JButton])
btnThree [JButton])
btnFour [JButton]
btnFive [JButton]
btnSix [JButton])
btnSeven [JButton]
btnEight [JButton]
btnhine [JButton]
btnZero [JButton]

Delete the default text, and enter a
number instead.

Then change the size of each button
to 50, 30.

Finally, change the font property of
each button.

Le] (s Le]
Lz (] Ls]
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Only three more buttons to add: a
plus button, an equals button, and a
clear button.

our calculator doesn’t have any
room on the right.

But you can easily resize a form.

Click on just the form, and not the
panel or the text field.

If you do it right, you should see an
orange rectangle surrounding the
form.

L]

L2 ]

L3 ]

L]

Ls ]

Le ]

[za

Le ]

Lo ]
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Now move your mouse to the edges
of the form.

The mouse pointer should change
shape, as in the image below (bottom
right):

L]

L2 ]

L3 ]

L]

Ls ]

Le ]

[za

Le ]

Lo ]
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Add a panel in the space you’ve
just created:

Add three buttons to the new L. 2 =]
panel. Change the variablesnames [ 4] [ 5] [ |
to: btnPlus, btnEquals, and (7] [a] [
btnClear. ]

For the text for the buttons, type a
+ symbol for the Plus button, a =
symbol for equals button, and the
word “clear” for the clear button.

Dr. Ahmed ElShafee, Fundamentals of Programming Il, Fall
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Change the font to the same as the
number buttons, 14 point bold.

The size for the N EN &3
plus and equals button should be [4a] [s5] [s] (=]
the same as the number buttons: Lz I o IR s [ e |

50, 30. For the

Clear button, change it to 70, 30.
Your form should then look like
this:

(o]
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:JavaCalculator.java ... :Inspector

* The Inspector area of NetBeans & Form JavaCalculator

should look like this: &3 Other Components
=-{_| [IFrame]

* You can run your form at this stage, ) txtDisplay [JTextField)

. . . = D jPanell [JPanel]
just to see what it looks like: T @ btnOne [JButton]

— btnTwo [JButton]
B calculator @@@ btnThree [JButton]

. btnFour [JButton]

| btnFive [JButton]
btnSix [JButton]
btnSeven [JButton]
btnEight [JButton]
btnNine [JButton]

] . . btnZero [JButton]
haZenl a8 | 9 | | Clear | =-|_| jPanel2 [IPanel]
+-[0K] btnPlus [JButton]

| o +-[0K] btnEquals [JButton]
~-[0K] btnClear [JButton]

EEREREEERER

4 x
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Events

In programming terms, an event is when something special
happens.

For forms, this means things like buttons being clicked, the
mouse moving, text being entered into text fields, the
programming closing, and a whole lot more.
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If we want to add 3 + 2, we first need to click the 3 button.
The number 3 will then appear in the text field.

The plus button is clicked next, and this alerts the program to
the fact that we want to add things.

It will also clear the text field ready for the next number.

The next number is 2, and we store this value along with the
3.

The equals button is clicked to get the total, and this is where
we take the stored numbers (3 and 2) and add them together.

Finally, the answer is stored in the text field.

Dr. Ahmed ElShafee, Fundamentals of Programming Il, Fall
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The first problem is how to get at the numbers on the
buttons.

We can do this by eturning the text property of the button.
Once we have the text, we can put it into the text box.
But we need an ActionEvent for when the button is clicked.

Dr. Ahmed ElShafee, Fundamentals of Programming Il, Fall
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: <init> - Navigator ‘Inspector x|
.E Form JavaCalculator .
+ 83 Other Componer  Edit Text
(] [IFrame] Change Variable Name ...

* In Design view in NetBeans, select 53 btdispley (] g
=[] jPanell [IPa

your number 1 button. o

~[95) btnTwo|

* Now have a look at the Inspector @ binThreq  Anchor

- [0¥] btnFour Auto Resizing

window in the bottom left. @ boive |

(2K btnSix[1  Set Default Size

* Locate your btnOne button. o o] T co.

Enclose In »

v w

v v w w

. . 5 (85 btnNine
* Now right click to see the following o >
& jPanel2 [Pa 0o Up

menu appear: poveLp
* Select Events from the menu. cut curex

Copy Chrl+C
Duplicate Ctrl+D

* From the submenu, click on Action, i .
and then actionPerformed: | Customizs Codo

Properties

rq Dr. Ahmed ElShafee, Fundamentals of Programming Il, Fall
2013

Edit Text
Change Variable Name ...
Bind »

Events Action actionPerformed

Ancestor

« Orsimply double click the button e o

Auto Resizing Container

Focus
Set Default Size

Space Around ¢

HierarchyBounds
Enclose In

InputMethod
Item
Key

HomLP Mouse

'._
»
»
»
»
»
Hierarchy »
»
»
13
»
3
Move: Do MouseMotion ¥
Cut MouseWheel »
Copy PropertyChange »
Duplicate VetoableChange »

Delete Delete |
Customize Code

Properties
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* When you click on actionPerformed, you will create a code
stub for btnOne:

private void
btnOneActionPerformed(java.awt.event.ActionEvent evt) {

// TODO add your handling code here:
}

* The first line is just a method with an ActionEvent object
between the round brackets.

* When the button is clicked, whatever code we write between
the curly brackets will get executed

Dr. Ahmed ElShafee, Fundamentals of Programming Il, Fall
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setText

* if wanted to put something into the text field, the method to
use is

txtDisplay.setText( btnOneText );
getText

* To get text from a form object, you can use the getText
method of the object (if it has one).

* Soto get the text from btnOne we could use this code:
String btnOneText = btnOne.getText( );
String textfieldText = txtDisplay.getText( );

Dr. Ahmed ElShafee, Fundamentals of Programming Il, Fall
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Add this code to your code stub:

B private void btnOneActionPerformed (java.awvt.event.ActionEvent evt) {

String btnOneText = btnOne.getText( )
ctxtDisplay.setText (btnOneText) ;

B calculator Q@@
Run your program and test it out.

Click your 1 button and you should
find that the number 1 appears in

the text field: el el g L=
R | P (S - l Clear |
0

Dr. Ahmed ElShafee, Fundamentals of Programming Il, Fall
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There is a problem, however.

What if you want to enter the number 11, or the number
111? When you click the button repeatedly, nothing else
happens.

It’s always a 1, no matter how many times you click.

To do that, you can simply get the text from the text field and
combine it with the button text. Amend the first line of your
code to this:

private void btnOneActionPerformed (java.awvt.event.ActionEvent evt) {

String btnOneText = txtDisplayv.getText () + btnOne.getText():
cxtDisplay.setText (btnOneText) ;

Dr. Ahmed ElShafee, Fundamentals of Programming Il, Fall
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* Repeat last step for the buttons

from0Oto9 111 |

E
- ‘ B ‘ l . I!EHII
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private void btnOneActionPerformed(java.awt.event. ActionEvent evt) {

String btnOneText = txtDisplay.getText () + btnOne.getText():
txtDisplay.setText (btnOneText) ;

private void btnTwoActionPerformed(java.avt.event. ActionEvent evt) {

String btnTwoText = txtDisplay.getText () + btnTwo.getText():
txtDisplay.setText (btnTwoText) ;

private void btnThreeActionPerformed (java.avt.event. ActionEvent evt) {

String btnThreeText = txtDisplay.getText() + btnThree.getText():
txtDisplay.setText (btnThreeText) ;

private void btnFourActionPerformed(java.awt.event.ActionEvent evt) ({

String btnFourText = txtDisplay.getText () + btnFour.getText():;
txtDisplay.setText (btnFourText) ;
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* Run your calculator and test it out.
* You should be able to enter all the numbers from 0 to 9:

4 calculator

|1 234567890

hanlall 2 ‘3| +

Dr. Ahmed ElShafee, Fundamentals of Programming |1, Fall
2013

private void btnFiveActionPerformed (java.awt.event.ActionEvent evt) ({
String btnFiveText = txtDisplay.getText() + btnFive.getText():
txtDisplay.setText (btnFiveText) ;

private void btnSixActionPerformed(java.awt.event.ActionEvent evt) {
String btnSixText = txtDisplay.getText() + btnSix.getText():
txtDisplay.setText (btnSixText)

private void btnSevenActionPerformed(java.awt.event.ActionEvent evt) {
String btnSevenText = txtDisplay.getText () + btnSeven.getText():
txtDisplay.setText (btnSevenText) ;

}

private void btnEightActionPerformed (java.awt.event.ActionEvent evt) {
String btnEightText = txtDisplay.getText() + btnEight.getText():
txtDisplay.setText (btnEightText) ;

private void btnNineActionPerformed(java.awt.event.ActionEvent evt) {
String btnNineText = txtDisplay.getText() + btnNine.getText():
txtDisplay.setText (btnNineText) ;

private void btnZeroActionPerformed(java.awt.event.ActionEvent evt) ({
String btnZeroText = txtDisplay.getText() + btnZero.getText():
txtDisplay.setText (btnZeroText) ;




The plus bottom

The next thing to do is to handle the plus button.

The only thing our plus button needs to do is to store
whatever number is currently in the text field.

It’s just a record of the first number to be added.

To store the value, we need to set up a field variable, that’s a
variable outside of any button code.

This is so that all the buttons can see what has been stored

public class JavaCalculator extends javax.swing.JFrame {

private double totall = 0.0;

public JavaCalculator ()

Double click your Plus button to generate the code stub.
Now add the following two lines to your plus button:

private void btnPlusActionPerformed(java.awt.event.ActionEvent evt) {
totall = totall + Double.parseDouble( txtDisplay.getText( ) ) :

txtDisplay.setText ("");
¥

Once the number is stored, we’ve cleared the text field.

The user can now enter a second number to be added to the
first.
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The Equals Button

After the user has chosen a second number, the equals button
needs to be clicked.

Clicking the equals button will produce the answer to the
addition.

To store the output of the calculation, we can set up another
field variable.

Add the following line to the top of your code:

public class JavaCalculator extends javax.swing.JFrame {

Il

private double totall
private double total2

0.0;
0.0;

public JavaCalculator () {
initComponents() ;
H

To get the answer to the calculation, we take whatever is
currently stored in totall and add it to whatever is currently in
the text field.

get the text from the text field and converts the string into a
double.

The result is then added to totall.
The answer is then stored in the total2 variable.
display the answer to the calculation back into the text field.
clear the totall variable
private void btnEqualsActionPerformed(java.avt.event.ActionEvent evt) {
t.::tal;é = ruu +:-l)\|::|.1..x.}:.)1:2..pc‘;'rs:.43D;u;al;( txtDisplay.getText( ) ):

txtDisplay.setText( Double. toString( totalZ) ):
totall = 0;




The Clear Button
* The only thing left to code for now is the Clear button.

* For this, we need to clear the total2 variable and set the text
in the text field to a blank string.

private void btnClearActionPerformed (java.awvt.event.ActionEvent evt) {

totalZ = 0O;
txtDisplay.setText (""):
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Exercises

Exercise 1

* There is one thing missing, however — a point symbol. At the
moment, your calculator can’t handle sums like 23.6 + 35.8.
So add a point button to your form.

* Write the code for it.

* (Hint—it’s practicalli the same code as for your number
buttons. ) HCaIcuIalnr El@@

59.4

:4..5 = (5]

7 8 9 Clear

1, Fall




Extending the Functionality of your
Calculator

* Now that the plus button is working OK, we can add buttons
to subtract, divide and multiply.

* Just like the addition button, however, these buttons won’t do
any calculations: the equals button will still do all the work.

* The only thing the operator buttons will do is to record which
button was clicked: add, subtract, divide, or multiply.

* The first thing to do is to place some more buttons on your
form.

* Inthe image below, we’ve moved the Clear button, and put all
the operator buttons in the panel to the right.

* Feel free to come up with your own design, though:
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B calculator Q@@
1 2 3 +
1 3 6 / K
7 8 9 =
0 Cl

Dr. Ahmed ElShafee, Fundamentals of Programming Il, Fall
2013




* Once you’ve added the new buttons, rename the default
variables to btnSubtract, btnDivide, and btnMultiply.

* The technique we’ll use to get which operator button was
clicked is to store the button text in a field variable.

* We can then use a switch statement to examine which
character is in the field variable.

* |[fit’s the + symbol we can add; if it’s the symbol we’ll
subtract; if it’s the / symbol we’ll divide; and if it’s the *
symbol we’ll multiply.
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* Add the following field variable to the top, just below your
other two:

public class JavaCalculator extends javax.swing.JFramwe {
private double totall = 0.0;

private double total2 0.0;
private char math operator:

public JavaCalculator() {
initComponents () ;
}
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* We can set up a method to get at the character on the button
that was clicked.

* Add the following method to your code:

private void getOperator (String btnText) ({
math operator = btnText.charlc (0);
totall = totall + Double.parselDouble(txtDisplay.getText()):
txtDisplay.setText ("") ;

* We've called the method getOperator.
* It’s a void method, so won’t return any value

* we have a String variable called btnText. This is obviously the
text from the button that was clicked
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* The charAt method of strings will get a character from a
string.

* The character you want goes between the round brackets of
charAt.

* The math symbol from our buttons is always at character O in
the string.

* This is then stored in the char field variable we’ve just set up
at the top of the code.

* Notice the other two lines in the code. They are exactly the
same as the lines from the plus button, doing exactly the
same thing — storing the first number in the variable called
totall.
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* So locate your btnPlus code and delete the following two lines
from it:
private void btnPlusActionPerformed (java.avt.event.ActionEvent evt) ({
totéli.=.ﬁ0tél1 +”ﬁ;uﬁié.p§rsénsﬁbie( txcDisplay.getText( )} )

txtDisplay.setTexc ("'")
}

* Replace them with these two lines:
private void btnPlusActionPerformed|(java.awt.event.ActionEvent evt) {
String button _text = btnPlus.getText():
getOperator (button_text):
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* The same two lines can be added to the other operator
button, only changing the name of the button.

private void btnSubtractActionPerformed(java.awt.event.ActionEvent evt) {
String button_text = btnSubtract.getText():
getOperator (button_text);

H

private void btnMultiplyActionPerformed(java.avt.event.ActionEvent evt) ({

String button_text = btnDivide.getText():
getOperator (button_text):;

private void btnMultiplyActionPerformed (java.avwt.event.ActionEvent evt) ({
String button text = btnDivide.getText():

getOperator (button_text):;
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* For the equals button, we can set up a switch statement to
examine what is in the math_operator variable.

switch ( math _operator ) ({

case '+':
total2
break;
case '
total2
break;
case '
total2
break;
case '*';:
total2
break:;

totall + Double.parselouble(txtDisplay.getText()):

totall - Double.parselouble(txtDisplay.getText()):

totall / Double.parseDouble(txtDisplay.getText()):

totall * Double.parselDouble(txtDisplay.getText()):

- txtDisplay.setText (Double. toString(total2));
totall = 0;

Enhancing Your calculator

public class From0Ol extends javak.swing.JFrame {
private double totall=0,total2=0;
private char op:;
private Boolean newOp=true;
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private void btnOneActionPerformed (java.awt.event.ActionEvent evt) {
if (newOp)
{
txtDisplay.setText (btnCne.getText ()):
newOp=false;
}
else
txtDisplay.setText (txtDisplay.getText () +btnOne.getText ()):

private void btnTwoActionPerformed(java.awt.event.ActionEvent evt) {
if (newOp)
{
txtDisplay.setText (btnTwo.getText()):
newOp=false;
}
else
txtDisplay.setText (txtDisplay.getText () +btnTwo.getText ())
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private void btnEqualActionPerformed(java.awt.event.ActionEvent evt) {
switch (op)
{
case '+':
total2=totall+Double.parseDouble (txtDisplay.getText()):
break;
case '-':
total2=totall-Double.parseDouble (txtDisplay.getText()):
break;
case 'X':
total2=totall*Double.parseDouble (txtDisplay.getText()):
break;
case '/':
total2=totall/Double.parseDouble (txtDisplay.getText()):
break:
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Thanks,

See you next Lecture, isA
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